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2. Introduction 

SMART is a windows based software which supports modbus (485, TCP-IP) device products. It 
provides true data collection and monitoring function, such collected data will be view in tabular, graph, 
zoom observation, file saving, and dynamic transfer to (ms excel, spreadsheet, pdf, open office and 
text) without any need for annoying programming. This software is basically “Scalable Monitoring, 
Archiving & Reporting Tool” so-called SMART. 

Software is designed to streamline the process of downloading data and reviewing it in a user-friendly, 
time efficient manner. The software offers many customizable features and options, user can add 
masibus products manually and from auto device discovery facility, software includes many types of 
reports as (daily data report, interval data report, monthly data report, monthly comparison of tag data 
and many more), it also includes displays like tabular (using a data table report allows the user to view 
the data and channels in a data table format) and trend (easily mark a desired point in time on any 
graph using time markers. Time markers appear as a vertical line in a graph), independently set scale 
units (for multiple parameter users can now choose to scale each channel independently to control 
how data is compared and viewed), including the ability to change engineering units (customizable 
engineering units enables users to support and program devices with many different unit types), 
multiple device communication (software can communicate with multiple devices through single 
interface cables). 

This software generates masibus products channel tags automatically, user can configure masibus 
devices and add tags for third party modbus devices which can be used to configure reports and 
displays. This software also has time stamped data logging facilities. User can configure software 
authentication password as per their requirement.  

This software is capable to run on almost all windows based operating systems of windows 7 and 
above, other windows based server versions 2003 and above. 

Thank you for choosing SMART for all of your data logging needs. 
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3. Software Installation Guide 

3.1 System Requirement 

Before you install the application verify that you have at least the following. 

Hardware 

Computer:    Pentium III / Celeron 866 MHz (or equivalent) or later (32-bit) 

    Pentium 4 G1 (or equivalent) or later (64-bit) 

Processor:   1 GHz or faster processor 

Memory:     1 GB (recommended 2 GB) 

Hard Disk:   4.5 GB of available hard disk space (x86) 

    4.5 GB of available hard disk space (x64) 

Monitor:     Resolution should be set at 1280 x 768 Pixels (recommended 1366 x 768) 

Color Palette:    Software contains 16-bit color graphics. It requires a minimum color palette                    

    setting of 16-bit color. 

Software 

Operating System:  Windows 7 (32 and 64-bit) 

    Windows 8 (32 and 64-bit) / 8.1 (32 and 64-bit)  

    Windows 10 (32 and 64-bit) 

    Windows server 2003 (32-bit) 

    Windows server 2008 R2 (64-bit)    

   Windows server 2012 R2 (64-bit) 

Additional Software Requirement:    

    Acrobat Reader 10 or higher version 

    Microsoft Office 2013/2010/2007/2003 

    Microsoft .NET Framework 4.0 or higher version required 

NOTE: 

The following list describes restrictions for using software on windows: 

 You cannot access software using a guest account on windows. 

 Although the software is designed to work with the windows operating systems listed above, 

software cannot guarantee operation on OS’s no longer supported by Microsoft support life 

cycle policy. 

 Software does not support windows 2000 / NT / Me / 98 / 95 / XP / windows vista. 
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3.2 Steps to install SMART 

1) To install the SMART software from a drive, insert the installation source disk into the CD 

drive, setup.exe file is available in the Setup\Volume\ folder as shown in below image. 

 

 
2) Double-click the setup.exe (application) to launch the installer options, when the installation 

welcome screen appears, click Next for the installation directory screen. The user can change 
the installation folder, if required. It is recommended to keep it at the default and then click on 
the Next. 

         

3) Installer will appears masibus and national instruments software license agreements. Read 

the license agreement and accept it. 

 

           

4) When accepting both the license agreement respectively, click on the Next twice and start the 

installation as described in next screen 1. The following dialog box will appear when the 

SMART have been successfully installed as shown in screen 2. 
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 Click on Next, SMART License 

Hardware Key driver installation 

window will appear. It is 

recommended to install driver for 

license key. 

NOTE: User need to manually select 

USB Dog driver (for USB Port in PC) 

OR Parallel Dog   Driver (For Parallel 

Port in PC). After selecting proper 

driver click on the Install Driver, it will 

start the installation, when installation 

is completed driver installation status 

window will appear as shown in 

screen. 

 

 

5) Now drive install setup program will 

install .NET Framework 4.0 Client 

profile setup. User need to select OK 

to install .NET Framework or Cancel 

to discard. 

 If the .Net 4.0 Framework has already 

been installed and you attempt to run 

the install .Net 4.0 Framework, a 

window asking to repair or remove the 

.Net 4.0 Framework will appear. It is 

recommended to select the Cancel 

button when this page appears. If the 

higher version of .NET Framework is 

present in the client PC, then it will 

automatically proceed to the next level. 

If user click OK button, setup will 

execute and extract to a suitable place. 
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 Installer will appears Microsoft software license term. Read the license and accept it and click 

on Install. When the Installation Is Complete screen appears, click Finish to exit the wizard. 

 

        
 

 You may be prompted to restart your 

computer dialog box when the SMART 

have been successfully installed. Click 

on the Restart. It is recommended to 

restart your system after installation to 

updates a DLL that is loaded in one or 

more processes that are required by 

Windows or makes changes to the 

registry. 
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4. Basic Operation 

This article explains the basic operation of SMART along with the procedure of data acquirement. 

4.1 Starting the Software 

To begin, launch the software by simply 

double clicking the desktop icon, or clicking 

the icon in the All Programs in the Start 

Menu. If application shortcut will not show as 

below with administrator access, you have to 

right click on it if you use a mouse and 

keyboard device. If you use a touchscreen, 

just press on the shortcut and hold. You 

should be able to see, an option 

 that allows you to run 

as administrator. If you run the application 

from an account without administrator 

permissions, the UAC prompt will ask you to 

enter the administrator password. If you don't 

provide the password, the program will not be 

launched.  

 

4.1.1 Startup Screen 

 Startup screen will display current 
version of the software. The 2nd 
figure shows the SMART in the 
windows toolbar. Once the software is 
open, the user can make any and all 
preference changes that are 
necessary. 

 

 
 
4.1.2 User Login 

 On starting SMART, following Login To Access screen will be display. Users who fail to 
authenticate within 30 seconds, the timeout period expires, and the user is allowed to retry 
authentication by again launch the software as discussed above. Enter correct Username and 
Password, press Login to go to the main screen. Press Close to exit from the SMART.  

 Default Username and Password - Admin. 

 Remember Me - It will save Username and Password to auto fill for next login. 
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 If windows cannot access database by any of the reason like the database folder has not 
been set up for read/write access to the user (access permission denied), database cannot 
open, this problem is most likely related to access rights provided to database converter by 
your operating system in such cases error message will be displayed. 

 

 If the user doesn’t have an active 
account or permission then 
the following dialog will be displayed. 
To login the user must have active 
account with necessary rights using 
access levels. 

 
4.1.3 Getting Started 

 After enter correct username and password user will redirect to following main screen. Each 

section of the software will be explained briefly in the following pages. Users with assigned 

access control level can configure initial setup or make necessary changes. 

 Software will run in following two modes 

1. Demo: This is a free version of software with limited no. of access points (00006). 

2. License: Using USB flash drives, a software protection dongle (commonly known as 

a dongle or key) to access licensed version of software with assigned number of points. 

 Thank you for purchasing SMART. This getting started guide describes how to use SMART. 

This article describes the simple step by step procedure for initially preparing the software 

with your host computer. The SMART is freely available as a demo version. User can 

purchase license key with required points. 

Note: An alternative way to make sure the key’s serial number is correct is to roll mouse on 

License info taskbar. The program will show tip tool with all information of key which will 

attached to the computer via the USB interface as shown below. 

 

 
 

 

 

 

http://en.wikipedia.org/wiki/USB_flash_drives
http://en.wikipedia.org/wiki/Dongle
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4.2 The Menus & Toolbar 

Within the first upper tab titled, there are many different options that appear. Below is a brief 
description of every item. 

 

4.2.1 File Menu 

 The File Menu offers following commands.

SMART Settings 

 Use this command to edit the details of the Logger (logging data for historical trend – min 
1000msec max – 3600000msec) and TS Logger (logging data for report – min 15000msec 
max – 3600000msec) sample rate, company name and logo path which will be print in the 
report, Protect Sheet (password for excel sheet report) and Protect Workbook (password for 
excel report). 
 

 
 

 By default control information is as shown in above screen. 

 When user click SAVE, it will updated the information for future use. 

 The rate at which a network updates the real time parameters depends on various factors 
such as network speed, device response time, protocol type, total number of devices 
connected to the network. So if your network updates data from device within 2 seconds, 
setting a 1 second sampling rate is irrelevant. The default 
value you can modify by above wizard. Make sure that 
monitoring service is not running. 

 Protect Sheet / Workbook password can be view in four 
different display as shown in figure. 
 

SMART Report 

 No database server, no SQL programming, no report designer but still you have all those 
reports. 

 Reports can be generated in the form of a data table and will be displayed in the many file 
formats. All saved (as long as they haven’t been permanently deleted) will be located in report 
wizard. There are many types of reports to fit the user’s need, which will be detailed in further 
section to view the data of a report in a different file format, users can generate a new report 
using the same data. 

Exit 

 Use this command to end your session. You can also use the Exit button.                  

 This action will terminate all services associated with SMART software. When user clicks on 
exit, first it will ask for the login password (Access password). 

 Access password - To prevent from unauthenticated users, some critical configuration, 
parameters changing and exit or logoff user needs to enter login password to access this 
functionality. When user enter correct password, it will ask to save network configuration (if 
network was created). 
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4.2.2 Edit Menu 

 The Edit Menu offers following commands. 
 

Profile Settings 

 When login user want to change the 
password , click on the Profile Setting, 
below window will appear. Now enter 
the Old password and New password . 
Enter the same password in the 
Confirm password box which you have 
enterd in the New password box. Now 
click on the SAVE to change the 
password. 

User Management 

 Only administrator user has the access rights to view and update the user details. 
When click on User Management Menu (also through shortcut), it will ask for the password to 
view the details. After correct password user can view the following screen. 
 

 
 

 User can view details of existing user accounts, create new user accounts, edit or delete any 
user accounts. 

 User can create maximum 1000 user accounts and assign different access levels like 
administrator, supervisor or operator to those accounts. 

 Since an administrator account is required to create other user accounts, you're assured to 
have at least one administrator account in your software. 

 The Administrator account has full control of the software and can assign other user rights. 
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Copy Network Config 

 To create a new device network configuration using the same 
data as the previous network (only configuration removed from 
SMART software), users will need to create a blank device 
network as shown in below tree navigation, the Copy Network 
Config menu will enabled. Select the data file manually from 
previous device network configuration file “Network.db” by click 
on menu, user can view the explorer screen. 

 

      
 

 The device network will be copy if and only if from previous configuration file that all devices 
and their respective tags which are used in that network must be present in SMART 
database. If fail to do so results in error to copy device network configuration. 

 Successful duplication will shows all devices in Device Network tree navigation and all tags in 
Tag Wizard window as same as previous device network configuration. 

Logout 

 Use this command (also through shortcut) to logout form current user account.                               

 This action will terminate all services associated with SMART software. When user clicks on 
Logout, first it will ask for the login password.  

 

 When user enter correct password, it 
will ask to save network configuration 
(if network was created) same as 
while exit from SMART and it will 
logout from current user account and 
login screen will be display. 

4.2.3 View Menu 

 The View Menu offers following commands. 

 

Trend Wizard 

 Use this command (also through shortcut) to view the current trend as well as historical trend 
stored in the database, as it will be discussed in the next section. 
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Report Wizard 

 Use this command (also through shortcut) to generate the data report which was created from 
SMART Report wizard. User also can delete those reports permanently from this Report 
Wizard, as it will be discussed in the next section. 

 

Database Status 

 As your database file fills up with the data, its performance can degrade. User can switch to 
new device network as it will creates and assigned to new databases. User can see database 
status using this command and software will auto pop up it on software launch. 
 

         

4.2.4 Project Menu 

 The Project Menu offers following command, as it will be 
discussed in the below. 

 

Create Device 

 This command allows user to create any third party device to be used in device network 
configuration. 

 To create third party device click on menu, the pop up window will open as below. You need 
to write device name, if device name is acceptable then successful added massage will be 
pop up otherwise error message will be pop up. 

 If same device name was already 
present in SMART then warning 
massage will be pop up to save with 
different name. Space and some 
special characters are not allowed to 
be use in device name. 

 

 User can used this device to configure tags 
(will be explain in next section) and in device configuration for monitoring, logging, trends and 
report. 

Configure Device 

 Using this command user can create, edit or delete unique tags in such created third party 
devices. To configure such devices click on menu window will arrive as shown in below. 
 

 



SMART  
Doc Ref No: mSMR/om/101/00 
Issue No: 00 
 

Page 15 of 31  User Guide                                                                                   

 

 From device name drop control you can select device which you want to configure. Fill-ups all 
details of tag with non-repeated tag name (max 10 characters) and click ADD to create new 
tag for that device. 

 User also can edit or delete such created tags by right click on selected tag and click 
respective menu as shown below. 

 

 
 

 When user select any device from drop control it will shows all present tags in that device in 
table. 

 User can also create masibus devices tags in such created third party device from drop down 
selection menu directly. 

 Independently set the scale units of a tag, this feature allows users to independently edit the 
scale and position of individual channels within a graph to optimize presentation. User can 
change the scaling of channel by using properties window as shown in figure. For scaling as 
for example the actual process value for tag is 10000 and we have to display it as 1000.0 so 
for that we have to put following values in properties window. In this case user need to set 0 
in decimal point to avoid both scaling on single tag. 

 
Raw Full Scale: 10000    Eng Full Scale: 1000 
Raw Zero Scale: 0    Eng Zero Scale: 0 
 

 Another way to scaling is from decimal point, user can take care while apply scaling on tag. 
 

 

Replicate Device 

 Using this command user can make a clone 
of such created third party devices directly 
by change only unique tag names. To 
replicate device click on menu as shown 
below window will arrive, from drop down 
menu user can select any device for which 
they want to create clone (this future is used when more than one devices will be used in 
network with different slave). 
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 As user select any device the pop up 
window will open as below. You need to 
write device name, if device name is 
acceptable then successful added massage 
will be pop up otherwise error message will 
be pop up. If same device name was 
already present in SMART then warning 
massage will be pop up to save with 
different name. 

 When successfully device created tag list 
will be pop up to assign new non-repeated 
tags for clone device as shown below. When 
all tags are assigned with new names click 
PROCEED to complete the replicate 
process.  
 

 User must have to modify all tag names with 
unique names, after only they can go for 
further process, fails to do so can show 
warning massage and restrict to go further. 
 

 After successfully modified all tag names the 
process will end and it will create new 
device with its all tags for future used until 
the user will not delete it permanently from 
SMART. 

Delete Device 

 Using this command user can may 
delete such created devices from 
SMART permanently. To delete 
device click on menu as shown below 
window will arrive, from drop down 
menu user can select any device 
which they want to delete. 

  
 

 User can only delete those devices which are not configured in present device network. 

4.2.5 Operate Menu 

 The Operate Menu offers following commands.
 

Network Report 

 Reports can be generated in the form of a data table and will be displayed in the many file 
formats. User can directly create reports of previously device networks which was removed 
from the SMART using this command. It will be discussed in the next section. 

Delete Network 

 User can may delete old removed device 
networks with its all data from hard drive 
permanently using this command. To 
delete device network and its all data click 
on menu as shown below window will 
arrive, from drop down menu user can select any device network which they want to delete. 

  

 User can only delete that network which are not currently used in SMART. 
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4.2.6 Tools Menu 

 The Tools Menu offers following commands.

Calculator 

 Use this command to open the Calculator form SMART software to do some calculation 
regarding values of incoming data. 

Notepad 

 Use this command to open the Notepad form the SMART software to write and store 
something related to data logging and historical trend. 

4.2.7 Tag Wizard 

 After adding the device in network user can see the tags in Tag wizard as shown 
below. 
 

 
 

 Using this wizard user can select tags from 
device network to set in monitoring as well 
as logging. 

 User can add number of tag that they have 
license granted. If the user tries to add 
more, you'll receive a pop-up 
warning which will restrict to doing so as 
shown. 

4.2.8 Monitoring 

 By clicking this command user can start and stop monitoring of all selected tags from Tag 
wizard in main window as well as in trend window. It will be more discussed in the next 
section. 

 You need to stop service on different occasions as follows: 
 Configuration setting is modified. 
 Logging may be enabled or disabled for some selected tags. 
 Tags & associated mappings are added or modified. 
 Device settings are modified. 

 To stop the service, click on the above icon. 

 Please note that when service is stopped, data archiving is also stopped, and interval data is 
not available for that particular period. 
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4.2.9 Logging 

 By clicking this command user can start and stop logging of all selected tags from 
Tag wizard in logger as well as in time stamp logger. It will be more discussed in the next 
section. 

4.2.10 Refresh 

 This command is used with masibus device while user wants to reset all configurable 
parameters value to its default and selection to read/write in configuration mode. Using this 
command user also can select or deselect all parameters to write in device. 
 

       

4.2.11 Demo 

 SMART application software has been licensed with a hardware key. However, 
the application can be used without a hardware key in a demonstration (Demo) mode which is 
limited in number of points with full functionality. The screen similar to the following is shown, 
you can see that demo in the right pane as well as in toolbar info too. 

 

 

4.2.12 System Time 

 System date and time represents a computer system's notion of the passing of days and time 
on the calendar. 

4.2.13 Windows 

 This menu is reserved for future use. 

4.2.14 Help 

 The Help Menu offers help command, use this command to view user’s manual, features and 
functionality of SMART software. For further information described in this manual, please 
contact at support@masibus.com. 
 

 
 

 
 
 
 
 
 
 
 

 
 
 

 
 

 

http://en.wikipedia.org/wiki/Calendar_date
http://en.wikipedia.org/wiki/Calendar_date
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4.3 Screen Navigation 

This section explains the basic tree 
navigation and its information used in 
SMART. It contains mainly four 
navigations, named Device Network, 
Network & Devices, Device Mode and 
Configuration. As using the tree 
navigation, you can invoke different 
functions of SMART by selecting the 
respective option. Using the “Device 
Network” navigation, you can view 
added devices in network. You can 
use “Network & Devices” navigation 
for network configuration, add or 
remove devices and remove network 
configuration. Using the “Device 
Mode” you can see run mode or 
masibus device configuration mode. 
You can use “Configuration” 
navigation to read or write masibus 
device parameters configuration. 

4.3.1 Device Network 

 Device network configuration navigation tree will shows the 

added devices with its communication parameter detail 

which are used for monitoring, logging, trends and 

reporting. 

 First row shows the network name, then after com port for 

modbus 485 or IP address for modbus TCP-IP. After it all 

added devices with its respective slave ID in order of adding 

it to network. 

 User can configure only one network at a time either it will be modbus 485 or modbus TCP- 

IP. How to configure device netwok will discusse in next section. 

4.3.2 Network & Devices 

 Network & Devices navigation will allow user to add or 
remove network configuration, devices and auto search for 
masibus devices. 

Configure Network 

 For configuration of device network click on Configure Network. The pop up window will be 
open as shown below. 

 

 Serial – To configure network with modbus 485 protocol user can select Serial from radio 
button, the list of parameters will shows as screen. 

 Mode – user can select any mode either RTU or ASCII as per their devices protocol settings. 

 COM Port - user can select com port from drop down menu, it will shows all available com in 
system. 
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 Baud rate - is the rate of transmission. The 
default is 9600. 

 Parity - specifies the parity used for every frame 
to be transmitted or received. This input accepts 
the following values (none, odd and even). 

 Flow Control - sets the type of control used by 
the transfer mechanism. This input accepts the 
following values (None, XON/XOFF, RTS/CTS, 
XON/XOFF and RTS/CTS, DTR/DSR, 
XON/XOFF and DTR/DSR). 

 Serial Stop Bits - specifies the number of stop 
bits used to indicate the end of a frame. This 
input accepts the following values (1 stop bits, 
1.5 stop bits and 2 stop bits). 

 The recommended arrangement of the wires is 
as a connected series of point-to-point 
(multidropped) nodes, i.e. a line or bus, not a star, 
ring, or multiply connected network.  

 TCP/IP - To configure network with modbus 
TCP-IP protocol user can select TCP/IP from 
radio button, the list of parameters will shows as 
screen. 

 IP Address – is the address with which you want 
to establish a connection. This address can be in 
IP dot notation. If you do not specify an address, 
SMART establishes a connection to the local 
computer. 

 Port – is the local connection port. 

 Time Out - specifies the time, in milliseconds, for 
the write and read operations. The default is 
1000. 

 Delay b/w Polls - To allow the throttling of data 
request to the slave device the value entered is 
the delay time between read requests. Delay 
between polls is good because reduce a burden 
of server in case of many devices connected to 
it.

 Trend Update – The rate is the times in a 
milliseconds after that a trend display updates its 
buffer. 

 Trend Limit - The parameter shows how many 
hours of data are remains in trend, after which 
user can see data by selecting previous or next 
button in trend wizard. More hour means that trend kips more data which results in degrade 
performance. 

Discover Device 

 By This feature user can find the masibus device 
(It will search masibus devices in configured 
network parameters only like baud rate, parity, 

stop bits, etc.) automatically connected on 

modbus 485 network. For that user have to click 
on Discover Device. The window will pop up. It 
will find the connected device on network and 
auto create tags of these devices (when device is 
auto discover based on above parameters, it will 
create its respective monitoring parameter's tags 
with meaningful unique tag names). 
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Remove Network 

 Using this command user can may remove 
configuration from SMART or delete such 
created network data from PC drive 
permanently. To remove device network click 
on menu as shown below window will arrive, 
there are two options by which user can 
proceed. 

 

 Delete all data – if user select this option it will delete device networks configuration with its 
all data from hard drive permanently. 

 

 Configuration only - if user select this option it will remove device networks configuration 
from SMART only and data will be there for future use. User can used this configuration file 
for duplicate network configuration as discussed above and data will used to make report 
from “Network Report” menu and view trend from “Network Trend” option in trend wizard. 

Add Device 

 By This feature user can add the masibus device as 
well as third party created devices. For that user have 
to click on Add Device. The window will pop up. User 
can select device from drop down box and give non 
repeated slave ID for same network configuration and 
click ADD. 

 The list of already presented and added device will 
show, user can add or remove such devices in 
network configuration by checkbox and click OK. 

 

              

 
 
 
 
 
 

 

 When successfully device added, tag list pop up to 
assign new non-repeated tags for such device as 
shown. By default it will be tag names with appended 
slave ID, but if user wants they may assigned with new 
names and click PROCEED to complete the process. 
All devices are listed in Network Configuration 
navigation as above. 
  

 
 

Remove Device 

 Using this command user can may remove device 
from network configuration. To remove device from 
network select the device as shown above and click on 
menu. It will asking user login password followed by 
user confirmation. 

 

4.3.3 Device Mode 

 Device Mode navigation will allow user to view data 
monitoring or masibus device configuration. The Run Mode 
windows are used for observing and analyzing acquired data. 
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 Configuration Mode - if user select this option it will stop data monitoring and logging if it will 

be in progress and redirect to configuration window as shown below. 
 

 
 

4.3.4 Configuration 

 Configuration navigation will allow user to read / write 
configurable parameters data of masibus devices in 
Configuration Mode. Available parameters depend on the 
devices being selected. 

 Write Configuration - if user select this option it will update device parameters value as 
selected from wizard respectively. 

 Read Configuration - if user select this option it will update wizard parameters value from 
device. 
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4.4 Task Bar Information 

The frequently used information are prepared in Task Bar.  It contains mainly Communication Status, 
Logger Status, Licensing, Login details and PC Key Status. 

 
 
 Communication Status: On the status bar, a text color indicates its health status, green 

color shows SMART communicating with devices where red color shows there is an error. 
 

 Logger / Trend Status: A text color indicates its health status, green color shows SMART 
logging data into logger database where red color shows there is an error. 

 
 TS Logger Status: A text color indicates its health status, green color shows SMART logging 

time stamp data into logger database where red color shows there is an error. 
 

 Software License: It will display software license information, "Licensed" with supported 
number of points in the info bar. 
 

 Login User Details: It shows the login Username and it's account detail. 
 
 Caps Lock Status: Caps Lock is a button on a keyboard that changes if a letter should be 

capitalize or not. It is located in the position of a similar Shift lock key (and sometimes a Ctrl 
key) found in some other keyboard layouts. 

 
 Num Lock Status: Num Lock or Number Lock is a key on the numeric keypad of 

most computer keyboards. It is a lock key, like Caps Lock and Scroll Lock. Its state (on or off) 
affects the function of some of the keys, and is commonly displayed by an LED built into the 
keyboard. 

 
 Scroll Lock Status: Scroll lock is a lock key (typically with an associated status light) on 

most IBM-compatible computer keyboards. Depending on the operating system, it may be 
used for different purposes and applications may assign functions to the key or change their 
behavior depending on its toggling state. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://en.wikipedia.org/wiki/Numeric_keypad
http://en.wikipedia.org/wiki/Computer_keyboard
http://en.wikipedia.org/wiki/Lock_key
http://en.wikipedia.org/wiki/Caps_Lock
http://en.wikipedia.org/wiki/Scroll_Lock
http://en.wikipedia.org/wiki/LED
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5. SMART Trend 

SMART provides two types of display for online monitoring. These are trends and tabular. A trend log 
is a collection of time-stamp values. A trend type display is used for bar or line graph for one or more 
parameters. 
 

 
 
 Trend Update Rate - The rate at which the trend refresh it display, even a new value is 

available with it. Please note that logging rate and sampling rate specified has nothing to do 
with trend settings. It is only relevant to the display for which it has been specified. 

 

 Trend Limit - The limit after which the trend will discarded data records and left it for history 
trend. When a data is monitoring in real time, a graph displaying the data can be set to 
automatically scroll horizontally so the most recent readings are always displayed. 

 
 Display Properties - Display properties are specified for each individual trend. By default, 

SMART assigns a separate color to each of the trend and all other properties are same. 
Note: You can select up to 06 tags in a trend. 

 
 Auto Scale Axis (Locking the Vertical Scale of a Graph) - You use the auto range function 

to automatically adjust the trend x-axis and y-axis according to the range of the series 
displayed. The vertical scale of a graph can be locked to prevent any automatic adjusting 
from occurring when new data is added. Any values that lie outside the displayed range will 
not resize the graph view. To navigate in the trend in small steps, you scroll the x-axis in 
steps equal to the displayed page of the trend. To navigate in the trend in big steps, you click 
on previous or next button to displayed trend. 

 
 Export Data to Excel - Using an export data, the user can view the data and time from the 

current graph to a data table reports which will be exported to Microsoft Excel®. 

 
 Display Span - There are selectable time spans for these displays, this is specified for all 

trend. You set the trend time span of the x-axis relative to the series current end point time to 
automatically adapt the trend to display the current time and the latest records within the 
specific time span. 

 

 Zooming in a trend chart - Trend charts are a way to graphically present trend logs. A trend 
chart can contain one or more trend logs that are represented in the trend chart by lines or 
bars. You can also add and remove trend logs from a trend chart. This makes it easy to 
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compare different trend logs, for example the energy consumption compared to the average 
temperature. 

 By double clicking on tag names from tree menu user can select or remove tags to view data 
in trend as shown below. The color indicates selected trend data respectively. You zoom in to 
enlarge the scale of the trend to make the reading easier. 

 
 The trend contains a lot of tools for easy navigation in the chart. You can scroll or use the 

predefined settings to focus on the time span you want to see. 
 

 You can scroll the x-axis in small or big steps, or use the auto scroll function (center black 
button) to make the trend chart automatically synchronized and display the latest value of the 
trend chart series. 
 

 You can zoom in or out on the x-axis, the y-axis, or both axes, or zoom in a specific area of 
the trend chart, or use the auto range function to automatically adjust the trend chart x-axis 
and y-axis according to the range of the series displayed. You print a trend chart using the 
Print function in zoom in trend. Zoom in trend display only historical data. 
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 Trend will be shown as break when there is no data or error in communication. 
 

 
 
 Network trend - User can directly view trends of previously device networks which was 

removed from the SMART using this with selectable options to start with last record or to start 
from beginning. To view trends of an existing network, select it from drop down. Window will 
appears as shown, select network will pop up options. 
 

       
 
 A fixed value line represents a specific value on a graph that is selected by the user and can 

be changed at any time. 
 

 Minimum, maximum and average values are calculations based on the recorded data for that 
parameter for selected time only. 
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6. SMART Report 

SMART report is used for displaying and reporting archived data. No database server, no SQL 
programming, no report designer but still you have all those reports. SMART provides two types of 
reports. These are reports built with archived time-stamped and reports built with archived interval 
information. 
 
Reports built with archived time-stamped 
SMART tags such as historical trends. These are similar to reports available in the generic SCADA or 
HMI applications. 
 
Reports built with archived interval information 
It makes very professional quality reports in 
textual and excel templates. SMART report 
screen looks similar to the following. This 
chapter provides assistance in achieving 
optimum organization by outlining steps to 
create, delete or recover reports. Users can 
create a blank report by this wizard. Give 
report name and description, select report type 
whether this report is for single tag or for 
multiple tags. Select specify display period and 
interval. Select tags as you can see, the left 
pane displays the list of all available tags. You 
can select maximum 48 tags for a multiple tag 
report. Min scale & max scale fields define the 
range for displaying the selected parameters. 
You may specify in what multiple of units the 
values shall be shown in a report i.e. in 
multiple of 10, 100, 1000 or 10000. Select all 
settings as per you need and click SAVE. All 
saved, reports (as long as they haven’t been 
permanently deleted) will be located in report 
wizard. Selecting the field displays the details 
of all selected tags in the textual print report. 
 

 
The report wizard window will pop up as 
below. You have to select the day at the time 
of viewing the report. A report can also be 
renamed while it is opened. The report must 
be saved after it has been renamed in order 
for the new name to be applied once the report 
is closed. A report can be saved to a file or to 
the internal hard disk. 

 
User can create report in many file formats as 
shown. SMART enables you to create report 
data to a customized Microsoft Excel™ 
template file. Excel template files can be used 
to apply formatting, and to generate summary 
calculations. Reports can be deleted at any 
time. Once a report is deleted from the report 
wizard, it is permanently deleted and cannot 
be recovered. 
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File Formats 

 Excel (*.xls / *.xlsx) - Microsoft Excel has the basic features of all spreadsheets, using a grid 
of cells arranged in numbered rows and letter-named columns to organize data manipulations 
like arithmetic operations. 

 Portable Document Format (PDF) - is a file format used to present documents in a manner 
independent of software, hardware, and operating systems. Each PDF file encapsulates a 
complete description of a fixed-layout flat document, including the text, fonts, graphics, and 
other information needed to display it. 

 Spreadsheet - is an interactive computer 
application for organization, analysis and 
storage of data in tabular form. A 
spreadsheet consists of a table 
of cells arranged into rows and columns 
and referred to by the X and Y locations. X 
locations, the columns, are normally 
represented by letters, "A", "B", "C", etc., 
while rows are normally represented by 
numbers, 1, 2, 3, etc. 

 Text file - is a kind of computer file that is 
structured as a sequence of 
lines of electronic text. Windows use a 
common text file format, with each line of 
text separated by a two-character 
combination: carriage return (CR) and line 
feed (LF). 

 Open File Format - open document format 
for office applications (ODF), also known 
as open document, here we used filename 
extensions for documents is *.ods 
(spreadsheet). 

 

 Network Report - User can directly create 
reports of previously device networks 
which was removed from the SMART 
using this. To create reports of an existing 
network, select it from drop down. Window 
will appears as shown above. User can 
directly create report by selecting all 
parameters and click BUILD in network 
report wizard. 

 
Simple Reports 
These reports are displayed by aggregating base interval data (of same or different intervals) 
to higher common intervals i.e. 15, 30, 60, 120, 240, 480 or daily/monthly interval. 

 Daily data report 
This report shows the value of the parameters according to the type of tag selected for each 
day of a week or a month. If you have selected the “Maximum Value during Interval” type tag 
then the report shows the daily maximum value of the parameter of a week or a month. 
 

 Interval monthly data report 
This report displays interval wise value of desired parameters for the whole month. The 
aggregation of data is performed for all intervals for each day of the whole month. The value 
shown for an interval is the aggregation of data of all corresponding intervals of complete 
month. 

 

 Interval data report 
This report displays the interval wise data of the parameters associated to the selected tags 
for a particular day. 
 

https://en.wikipedia.org/wiki/File_format
https://en.wikipedia.org/wiki/Document
https://en.wikipedia.org/wiki/Operating_system
https://en.wikipedia.org/wiki/Font
https://en.wikipedia.org/wiki/Computer_application
https://en.wikipedia.org/wiki/Computer_application
https://en.wikipedia.org/wiki/Data
https://en.wikipedia.org/wiki/Table_(information)
https://en.wikipedia.org/wiki/Computer_file
https://en.wikipedia.org/wiki/Line_(text_file)
https://en.wikipedia.org/wiki/Electronic_text
https://en.wikipedia.org/wiki/Carriage_return
https://en.wikipedia.org/wiki/Line_feed
https://en.wikipedia.org/wiki/Line_feed
https://en.wikipedia.org/wiki/Filename_extension
https://en.wikipedia.org/wiki/Filename_extension
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 Monthly data report 
This report shows the significant value of parameter of a tag for the whole month. 

 

 Daily comparison of tag data 
This type of report is useful for having a comparative look on the daily data of selected tags. It 
is used to see the everyday value of the parameter. 

 
 Monthly comparison of tag data 

This reports displays the monthly values of the tags according to its significance for the 
number of months selected. You can select 1 to 12 numbers of months for generating the 
report. 

 
 Interval wise comparison of tag data 

This report displays the interval wise data summary for the selected tags. It means the tag 
name in the report is followed by its fetched values based on its significance, falling in each 
time interval for the selected day. You have to select the day at the time of viewing the report. 

 
 Interval wise comparison of tag monthly data 

The purpose of this report is to compare the various tags interval wise. This report shows the 
tag name followed by the values falling in each interval. Here the aggregation of data is 
performed for all intervals of all days for whole month. 

 
 Day of the month report (For Single Tag only) 

This report displays the value of a selected single tag as per its significance for each day of 
the month. You can select 1 – 12 numbers of months for generating this report. 

 
 Daily Comparison of Interval data (For Single Tag only) 

This report gives the daily comparison of interval data. It means that this report shows you the 
interval data of each day for the selected number of days. The data depends on the tag 
selected and the type of its significance like minimum, maximum, average etc. If you select 
the maximum type of tag then the report shows the maximum value of tag in each time 
interval of each day for the number of days selected. 

 
 Monthly Comparison of Interval data (For Single Tag only) 

This report shows the monthly significant value like maximum, minimum, average etc. of the 
tag for each interval of a day. You can select the interval of 15, 30, 60, 120, 240, 480, 720 
and 1440 minutes for 1-12 numbers of months. 

 

 Daily periodic data report 
This report shows the single day log data for a selected date. User can create this report for 
single tag as well as multiple tags (up to 48 tags). User have to select only one type from tag 
display (max, min, avg. or sum) because it will displays total logged records of the day. 
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7. Software Licensing Agreement 

SOFTWARE 
Masibus SMART software 
 
LICENSE 
Masibus Automation And Instrumentation Pvt. Ltd. ("Masibus") grants you a non-exclusive license to 
use the software listed in the section above ("software") if you follow all restrictions in all sections of 
this agreement. 

 
TITLE 
Title, ownership rights, and intellectual property rights in the software shall remain with Masibus. This 
software is protected by copyright laws and treaties. 
 
SCOPE OF GRANT 
You may 

 Install and use the software on any number of computers. 

 Allow any number of users to make use of the software (each user must run an individual 
instance of the software). 

 Make a copy of the software for archival purposes, if required. 

 
You may not 

 Copy the printed documentation which accompanies the software. 

 Sublicense, rent or lease any portion of the software. 

 License, reverse engineering, decompile, modify, translate, and make any attempt to discover 
the source code of the software, or create derivative works from the software or 
documentation. 

 Remove or alter any trademark, logo, copyright or other proprietary notices, legends, symbols 
or labels in the software. 

 Use the software in any manner not authorized by this license. 

 
MISCELLANEOUS 
Masibus reserves the right to change the terms of this agreement at any time without making those 
changes retroactive to past releases. Masibus may provide free upgrades to the latest version of this 
software through our web site http://www.masibus.com. To download product software you need to 
log in as a registered user. Product software files are visible only to log in users. 

 
SOFTWARE WARRANTY AND LIMITATION OF LIABILITY 
THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT WARRANTY OF ANY KIND, 
EXPRESSED OR IMPLIED. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF 
THE SOFTWARE IS BORNE BY YOU. IN NO EVENT SHALL MASIBUS BE HELD LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGE. 
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8. Contact Information 

For further information described in this manual, please contact at Masibus Automation And 
Instrumentation Pvt. Ltd. by phone or email: 
 
B-30, G.I.D.C Electronic Estate, Sector - 25, Gandhinagar - 382044. Gujarat - India. 
Phone: +91 79 23287275-79 
Fax: +91 79 23287281 
E-mail: support@masibus.com 
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